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Introduction

Purpose of this manual

This section describes how to install XDCAM Browser for 
use in Microsoft Windows. It assumes that readers have a 
basic familiarity with Microsoft Windows.

For details on operating this software, refer to the online 
help that is installed with this software or the User’s Guide 
(PDF).

Notes on use of XDCAM devices

• This software cannot access an XDCAM device while 
another XDCAM-compatible application is accessing 
that device.

• While running this software, if it becomes necessary to 
connect/disconnect the IEEE1394 cable or power on/off 
the XDCAM device, always do such operations after 
you exit this software.

Overview

The XDCAM Browser allows you to work with clips 
created with XDCAM EX/XDCAM devices.
After installing this application on your computer, you can 
use its intuitive graphical user interface to organize your 
clips by copying, moving, and deleting them. You can also 
perform format conversions, preview the clips, and view 
their metadata.
This software supports the following clip formats.

a) Referred to in this manual as “DV-AVI clips” or “DV-AVI files”.
b) Some functions are not supported.

SxS memory card that contains HQ 1440 clips or DV-AVI 
clips is not recognized as usable media by the PMW-EX1/
EX3/EX30.

Installing on 
Windows

Clip File format Extension

XDCAM EX format 
compatible clips

MP4 MP4

DV-AVI Type2 a)  b) AVI

XDCAM format clips MXF b) MXF

Note
5Introduction / Overview
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Hardware and software 
requirements

Install this application on a computer meeting the 
following hardware and software requirements.

a) To use keyword searching on Windows XP, Windows Desktop Search 
(WDS) must be installed. Keyword searching is not available if WDS is 
not installed or if the installed version is not the latest version.
The WDS component is preinstalled on Windows Vista and Windows 7. 
It does not need to be installed again. This software has been verified to 
operate in conjunction with WDS Version 3.10.

b) When viewing or printing exported clip information

Refer to the ReadMe file for XDCAM device versions 
supported by this application.

Installing the Drivers

To access files and use video material stored on a 
Professional Disc or SxS Memory Card with computer-
installed XDCAM Browser software or nonlinear editing 
software, the appropriate driver for each media type must 
be installed.
You can install the drivers from the Utility Software for 
XDCAM CD-ROM, or download them from the Web site.
The drivers for each media are as follows.

To use Professional Discs inserted in an 
IEEE1394-connected XDCAM device:
Install the FAM Driver from the CD-ROM.

To use Professional Discs inserted in an XDCAM 
drive:
Refer to the operating instructions for the XDCAM 
drive, and install the XDCAM Drive Software. The 
XDCAM Drive Software is not included on the 
XDCAM Browser CD-ROM.

To use SxS memory cards inserted in an 
ExpressCard slot:
Install the SxS Device Driver from the CD-ROM.

To use SxS memory cards in UDF format:
Install the SxS Device Driver and the SxS UDF Driver 
from the CD-ROM.
Be sure to install the SxS Device Driver first.

Installing from the CD-ROM

You can install the FAM Driver, SxS Device Driver, and 
SxS UDF Driver from the Utility Software for XDCAM 
CD-ROM.

1 Insert the CD-ROM into the CD-ROM drive of your 
computer.

The cover page appears automatically in your browser. 
If it does not appear, double click index.htm on the 
CD-ROM.

2 Click the driver you want to install.

The installer for the driver starts. Follow the 
instructions on the screen to install the driver.

For details, refer to the ReadMe file stored on the 
CD-ROM. 

XDCAM Drive Software installation
The XDCAM Drive Software is not included on this 
software CD-ROM. For details on installing the XDCAM 
Drive Software, refer to the operating instructions for the 
XDCAM drive.

Item Description

OS Microsoft Windows XP SP3 or higher (32-bit 
version), Microsoft Windows Vista SP2 or 
higher (32-bit version or 64-bit version), or 
Microsoft Windows 7 SP1 or higher (32-bit 
version or 64-bit version)

CPU Intel Pentium 4 2.0 GHz or higher (Intel Core 2 
Duo Processor 2.0 GHz or higher 
recommended)

Memory 1 GB or more (2 GB or more recommended)

Display Resolution: 1024 × 768 pixels or better

Audio Audio playback function

Other • Windows Desktop Search (WDS) a)

• Windows Internet Explorer 7 or higher b)
Installing the Drivers
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Confirming the driver version

If a driver is already installed on your computer, confirm 
that the following version of the driver or later is installed.
You can find the latest versions of drivers on the XDCAM 
Web site.

• FAM Driver: Ver. 2.3.0 or later
• XDCAM Drive Software: Ver. 3.1.1 or later
• SxS Device Driver: Ver. 1.1.0.0 or later
• SxS UDF Driver: Ver. 1.0.2 or later

To confirm the FAM Driver, SxS Device 
Driver, and SxS UDF Driver versions
Confirm the driver versions as follows from the Control 
Panel. The drivers are displayed under the following 
names in the Control Panel.
• FAM Driver: ProDisc
• SxS Device Driver: SxS Device Driver
• SxS UDF Driver: Sony SxS UDF Driver

For Windows XP
Select the driver in [Add or Remove Programs] of the 
Control Panel, and click [Click here for support 
information].

For Windows Vista

1 Select [Programs] > [Programs and Features] in the 
Control Panel, right click the header area where 
[Name] and [Publisher] are displayed, and select 
[More].

2 Select the [Version] check box in the [Choose Details] 
dialog, and click [OK].

A version column appears allowing you to confirm the 
version.

For Windows 7
Open [Programs and Features] in the Control Panel to 
confirm the driver version.

If your computer is equipped with a built-in ExpressCard 
slot, the SxS Device Driver may not appear. In such cases, 
obtain the latest driver using Windows Update.

To confirm the XDCAM Drive Software 
version
Use the XDCAM Drive Software utility software to 
confirm the software version.

Installing XDCAM Browser

If the MainConcept plug-in software is installed
Purchase or update to the full function version of 
MainConcept Conversion Pack at the MainConcept Web 
site. You can access the MainConcept Web site by 
selecting [About MainConcept Conversion Pack...] in the 
[Help] menu, and then clicking the URL in the dialog box 
that appears.

If you purchased the full function version of MainConcept 
Conversion Pack for use with XDCAM Browser version 
2.0 or earlier and then updated the XDCAM Browser 
version, you must download the plug-in software update 
that supports version 2.1 of XDCAM Browser.
For details, visit the MainConcept Web site.

Installing from the CD-ROM

1 Insert the supplied CD-ROM into the CD-ROM drive 
of your computer.

The cover page appears automatically in your browser. 
If it does not appear, double click index.htm on the 
CD-ROM.

2 Select and click [Windows XP/Vista/7] from the 
XDCAM Browser Installer. 

The folder where the setup application is stored 
appears.

3 Double click XDCAMBrowser.exe.

The setup wizard appears.

4 Click the [Next] button in the setup wizard.

A license agreement screen appears.

Note

Note
7Installing XDCAM Browser
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5 Click the [Accept] button, and then click the [Next] 
button.

The following screen appears.

6 Change the settings as required, and then click the  
[Next] button.

To change the installation destination
Click the [Browse...] button and select the folder in the 
dialog that appears.

Complete the installation by following the instructions 
on the screen.
The following screen appears when the installation 
finishes.

7 Click the [Finish] button to close the dialog.

To uninstall the application
Select Add or Remove Programs in the Windows Control 
Panel, and then select and delete [XDCAM Browser] from 
the list of installed programs.

Uninstalling the application also uninstalls the 
MainConcept plug-in software at the same time.

Launching and Exiting 
the Application

See “Installing XDCAM Browser” (page 7) for more 
information about how to install the application.

Launching the application

Double click the shortcut icon on the desktop.

It is not possible to launch more than one instance of this 
application at one time.

Exiting the application

Do one of the following.
• Select [Exit] from the [File] menu.
• Click the × button in the upper right of the operating 

window.

Do not power off the computer while a file operation is still 
underway. Files may be corrupted. Wait until the operation 
finishes, or cancel the operation, before powering off.

Note

Note

Note
Launching and Exiting the Application
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Media Operations

Handling Professional Disc files

When using an IEEE1394-connected 
device
When a Professional Disc device is connected via 
IEEE1394 to a computer on which the FAM Driver is 
installed, you can handle files using File Access Mode 
(FAM). You can handle the files stored on the Professional 
Disc device as you would files stored on a local drive or a 
network computer.

• This software does not support stream mode connections 
for IEEE1394.
For details on use other than in FAM, refer to the 
operating instructions for the supported device or editing 
software.

• For details on switching devices to FAM mode 
(displayed on the device as PC REMOTE) or 
information on device limitations, refer to the operating 
instructions for each device.

• When a device is connected using FAM for the first time, 
the [Found New Hardware Wizard] dialog appears. In 
such cases, select [Install the software automatically] to 
perform installation. Click [Finish] when the software 
installation finishes.

When using an XDCAM drive
When an XDCAM drive is connected via USB to a 
computer on which the XDCAM Drive Software is 
installed, you can handle files stored on the Professional 
Disc as you would files from a FAM-connected device.

Limitations and restrictions
• With the exception of the EJECT button, the control 

panel of the connected device is disabled.
• If you turn off power to a FAM-connected device or 

XDCAM drive while data transfer is in progress, the data 
will be damaged.

• Some operations may be disabled depending on the file 
type.

Ending Professional Disc operations
If storage media has been mounted, remove it by pressing 
the device’s EJECT button or by selecting eject from the 
computer’s context menu. If any files on the storage media 
are in use by applications, you may not be able to remove 
the media in this manner. In such cases, remove the disc 

from the application, or terminate the application and then 
remove the media.
When you are finished with operations, perform the 
procedure for safely removing devices from your 
computer before removing the device. Do not disconnect 
the device until the removal process is complete.

To remove an IEEE1394-connected device

For Windows XP/Windows Vista:

1 Double click the [Safely Remove Hardware] icon on 
the computer’s taskbar.

The [Safely Remove Hardware] dialog appears.

2 Select the device you want to remove, and click [Stop].

The [Stop a Hardware device] dialog appears.

3 Select the device you want to remove, and click [OK].

For Windows XP:
The selected device is removed from the 
[Hardware devices] list.

For Windows Vista:
The “This device can now be safely removed from 
the computer” message appears.

When the operation is complete, disconnect the IEEE1394 
cable if necessary.

For Windows 7:
Click the [Safely Remove Hardware] icon on the 
computer’s taskbar, and select [SonyXDCAM_“device 
name”] > [Remove “disc name”].
If a disc name is not configured, “XDCAM” is displayed.

When the operation is complete, disconnect the IEEE1394 
cable if necessary.

To remove an XDCAM drive

1 Click the [Safely Remove Hardware] icon on the 
computer’s taskbar.

2 Select the XDCAM drive you want to remove from the 
menu that appears.

3 When a message indicating that the card can be safely 
removed appears, disconnect the USB cable.

Notes
9Media Operations
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Handling SxS memory card files

You can access SxS memory cards inserted in devices 
connected as follows from a computer on which the SxS 
Device Driver or the SxS UDF Driver (when using UDF 
format) is installed.

• Connected via the ExpressCard slot on the computer
• Card readers/writers connected to the computer via USB
• XDCAM EX/XDCAM devices connected to the 

computer via USB

Information recorded for materials stored on an SxS 
memory card may span multiple files and folders. 
XDCAM Browser allows you to handle this information 
and file directories easily, without worrying about 
structure. However, if you use Windows Explorer to 
perform operations such as copying clips from the SxS 
memory card, the information stored with the clip may not 
be retained. To prevent such occurrences, we recommend 
performing file operations using supported applications.

For details on switching operation modes or information 
on device limitations, refer to the operating instructions for 
each device.

Limitations and restrictions
Do not perform the following operations while the 
computer is accessing the SxS memory card.
• Turn ON/OFF the XDCAM EX/XDCAM device or 

memory card reader/writer
• Remove or insert SxS memory cards
• Disconnect or connect USB cables
• Change the setting of the write protect switch on an SxS 

memory card

Ending SxS memory card operations

When using a card inserted in an ExpressCard 
slot
When you are finished with operations, perform the 
procedure for safely removing devices from your 
computer before removing the device. Do not remove the 
card until the removal process is complete.

1 Click the [Safely Remove Hardware] icon on the 
computer’s taskbar.

2 Select the SxS memory card you want to remove from 
the menu that appears.

3 When a message indicating that the card can be safely 
removed appears, remove the card.

When using an XDCAM device or memory card 
reader/writer connected by USB

1 Click the [Safely Remove Hardware] icon in the 
computer’s taskbar.

2 Select the XDCAM device or memory card reader/
writer to be removed from the menu that appears.

3 When a message indicating that the device can be 
safely removed appears, unplug the USB cable.

When removing an SxS memory card, always make sure 
that the access lamp is out.

Note
Media Operations
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Introduction

Purpose of this manual

This section describes how to install XDCAM Browser for 
use in Mac OS. It assumes that readers have a basic 
familiarity with Mac OS.

For details on operating this software, refer to the online 
help that is installed with this software or the User’s Guide 
(PDF).

Notation for special keys

This manual uses the following notation to indicate special 
keys.

Notes on use of XDCAM devices

• This software cannot access an XDCAM device while 
another XDCAM-compatible application (XDCAM 
Transfer) is accessing that device.

• While running this software, if it becomes necessary to 
connect/disconnect the IEEE1394 cable or power on/off 
the XDCAM device, always do such operations after 
you exit this software.

Overview

The XDCAM Browser allows you to work with clips 
created with XDCAM EX/XDCAM devices.
After installing this application on your computer, you can 
use its intuitive graphical user interface to organize your 
clips by copying, moving, and deleting them. You can also 
perform format conversions, preview the clips, and view 
their metadata.
This software supports the following clip formats.

a) Referred to in this manual as “DV-AVI clips” or “DV-AVI files”.
b) Some functions are not supported.

SxS memory card that contains HQ 1440 clips or DV-AVI 
clips is not recognized as usable media by the PMW-EX1/
EX3/EX30.

Hardware and software 
requirements

Install this application on a computer meeting the 
following hardware and software requirements.

a) To view or print exported clip information.
b) To use a function for registering clips from this software to Final Cut Pro. 

Select which version you are using in the environment settings. Final Cut 
Pro X is selected under default settings.
Rewriting back to media is not supported in Final Cut Pro X.

Refer to the ReadMe file for XDCAM device versions 
supported by this application.

Installing on 
Mac OS

Symbol Notation in this manual

Command

Shift

Option

Control

Return

Clip File format Extension

XDCAM EX format 
compatible clips

MP4 MP4

DV-AVI Type2 a)  b) AVI

XDCAM format clips MXF b) MXF

Note

Item Description

OS Mac OS X 10.6.4 or higher, or Mac OS X 10.7.1 
or higher

CPU Intel Core 2 Duo Processor 2.0 GHz or higher 
(Intel Core 2 Duo Processor 2.4 GHz or higher 
recommended)

Memory 1 GB or more (2 GB or more recommended)

Other Safari 4.0.2 or later a); Final Cut Pro 7 or Final 
Cut Pro X b)
11Introduction / Overview
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Installing the Drivers

To access files and use video material stored on a 
Professional Disc or SxS Memory Card with computer-
installed XDCAM Browser software or nonlinear editing 
software, the appropriate driver for each media type must 
be installed.
You can install the drivers from the Utility Software for 
XDCAM CD-ROM, or download them from the Web site.
The drivers for each media are as follows.

To use Professional Discs inserted in an 
IEEE1394-connected XDCAM device:
Install the FAM Driver from the CD-ROM.

To use Professional Discs inserted in an XDCAM 
drive:
Refer to the operating instructions for the XDCAM 
drive, and install the XDCAM Drive Software. The 
XDCAM Drive Software is not included on the 
XDCAM Browser CD-ROM.

To use SxS memory cards inserted in an 
ExpressCard slot:
Install the SxS Device Driver from the CD-ROM.

To use SxS memory cards in UDF format:
Install the SxS Device Driver and the SxS UDF 
Driver from the CD-ROM.
Be sure to install the SxS Device Driver first.

SxS UDF Driver Ver. 1.0.1 or later must be installed to use 
XDCAM Browser’s FAT formatting function for SxS 
memory cards. When using FAT-formatted SxS memory 
cards exclusively, the above driver must also be installed 
to use the operating life display function for SxS-1 
memory cards.

Installing from the CD-ROM

You can install the FAM Driver, SxS Device Driver, and 
SxS UDF Driver from the Utility Software for XDCAM 
CD-ROM.

1 Insert the CD-ROM into the CD-ROM drive of your 
computer.

2 Double click index.htm in the root folder on the 
CD-ROM.

3 Click the driver you want to install.

The installer for the driver starts, or the included disk 
image file appears. If the installer package is included 
in the disk image file, double click the file to start the 

installer. Afterward, follow the instructions on the 
screen to install the driver.

For details, refer to the ReadMe file stored on the 
CD-ROM.

XDCAM Drive Software installation
The XDCAM Drive Software is not included on this 
software CD-ROM. For details on installing the XDCAM 
Drive Software, refer to the operating instructions for the 
XDCAM drive.

Confirming the driver version

If a driver is already installed on your computer, confirm 
that the following version of the driver or later is installed.
You can find the latest versions of drivers on the XDCAM 
Web site.

• FAM Driver: Ver. 2.3.2 or later
• XDCAM Drive Software: Ver. 3.1.1 or later
• SxS Device Driver: Ver. 1.0.52020 or later
• SxS UDF Driver: Ver. 1.0.2 or later

To confirm the FAM Driver version
Start the System Profiler under [Application] – [Utilities] 
while the Professional Disc device is connected to the 
computer via an IEEE1394 cable and a Professional Disc 
is inserted.
Select [Extensions] under [Software], and the version 
appears under [prodisc_fs].

To confirm the SxS Device Driver and SxS 
UDF Driver versions
Start the System Profiler under [Application] – [Utilities] 
while the SxS memory card is inserted.
When you select [Extensions] under [Software], the SxS 
Device Driver version appears in the [SxS Memory Card] 
item, and the SxS UDF Driver version appears in the 
[sxsudf_fs] item.
To confirm whether the SxS UDF Driver has been 
installed on the computer, insert a UDF-formatted SxS 
memory card, select the SxS memory card, and confirm 
the format for the SxS memory card in [Get Info] of the 
menu.
“Professional Memory File” will appear if the SxS UDF 
Driver is installed. If “Universal Disk Format (UDF)” 
appears, install the supplied SxS UDF Driver. If the SxS 
memory card is formatted in the FAT format, “MS-DOS 
(FAT)” appears.

Note
Installing the Drivers
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To confirm the XDCAM Drive Software 
version
Use the XDCAM Drive Software utility software to 
confirm the software version.

Installing XDCAM Browser

If the MainConcept plug-in software is installed
Purchase or update to the full function version of 
MainConcept Conversion Pack at the MainConcept Web 
site. You can access the MainConcept Web site by 
selecting [About MainConcept Conversion Pack...] in the 
[XDCAM Browser] menu, and then clicking the URL in 
the dialog box that appears.

When transferring materials to Final Cut Pro
If you intend to use XDCAM Browser to transfer XDCAM 
EX/XDCAM materials to Final Cut Pro,  Final Cut Pro and 
a codec supporting the latest XDCAM series must be 
installed before installing XDCAM Browser. 
Refer to the ReadMe file for Final Cut Pro versions 
supported by this application.

Installing from the CD-ROM

1 Insert the supplied CD-ROM into the CD-ROM drive 
of your computer.

The disc icon appears on your desktop.

2 Double click the disc icon.

The contents of the CD-ROM appear.

3 Double click index.htm.

The cover page appears in your browser.

4 Select and click [MAC OS X] from the XDCAM 
Browser Installer.

Finder starts and XDCAMBrowser.dmg appears.

5 Double click XDCAMBrowser.dmg.

Finder starts and XDCAMBrowser.pkg appears.

6 Double click XDCAMBrowser.pkg.

The installation screen appears.
13Installing XDCAM Browser
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7 Click the [Continue] button.

A license agreement screen appears.

8 Click the [Continue] button.

The following message appears.

9 Click the [Agree] button.

A screen appears in which you can select the 
installation destination.

10 Click the installation destination volume.

11 Click the [Continue] button.

The following screen appears.

12 Click the [Install] button.

An authentication screen appears.

13 Enter your name and password, and then click the 
[OK] button.

The following screen appears when the installation 
finishes.

14 Click the [Close] button to close the dialog.

To uninstall the application
Perform steps 1 to 5 in “Installing from the CD-ROM” 
(page 13), and double-click XDCAMBrowserUninstaller.
When the confirmation message appears, click [OK] to 
continue.

When you uninstall this software, MainConcept plug-in 
software and Final Cut Pro plug-ins will also be 
uninstalled.

Note
Installing XDCAM Browser
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Launching and Exiting 
the Application

See “Installing XDCAM Browser” (page 13) for more 
information about how to install the application.

Launching the application

Use Finder to open the XDCAM Browser folder in the 
Applications folder, and double click XDCAM Browser.
The application starts, and the operating windows appear.

It is not possible to launch more than one instance of this 
application at one time.

Exiting the application

Select [Quit XDCAM Browser] from the [XDCAM 
Browser] menu.

Do not power off the computer while a file operation is still 
underway. Files may be corrupted. Wait until the operating 
finishes, or cancel the operation, before powering off.

Media Operations

Handling Professional Disc files

When using an IEEE1394-connected 
device
When a Professional Disc device is connected via 
IEEE1394 to a computer on which the FAM Driver is 
installed, you can handle files using File Access Mode 
(FAM). You can handle the files stored on the Professional 
Disc device as you would files stored on a local drive or a 
network computer.

• This software does not support stream mode connections 
for IEEE1394.
For details on use other than in FAM, refer to the 
operating instructions for the supported device or editing 
software.

• For details on switching devices to FAM mode 
(displayed on the device as PC REMOTE) or 
information on device limitations, refer to the operating 
instructions for each device.

When using an XDCAM drive
When an XDCAM drive is connected via USB to a 
computer on which the XDCAM Drive Software is 
installed, you can handle files stored on the Professional 
Disc as you would files from a FAM-connected device.

Limitations and restrictions
• Do not use the EJECT button to eject the Professional 

Disc. Always perform the disc eject operation from the 
computer.

• Do not unplug an IEEE1394 or USB cables from 
FAM-connected devices or XDCAM drives without first 
performing the procedure for safely removing the 
devices. Doing so may result in unstable operations.

• Some operations may be disabled depending on the file 
type.

Ending Professional Disc operations
When you are finished with operations, perform the 
procedure for safely removing devices from your 
computer before removing the device. Wait until the 
removal process is complete and verify that the access 
lamp is out before disconnecting the device.

Note

Note

Notes
15Launching and Exiting the Application / Media Operations
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To remove an IEEE1394-connected device
Click the eject button to the right of the disc icon of the 
target device in the Finder, or drag the disc icon to the trash 
icon.
The Professional Disc is ejected, and the FAM connection 
is disabled.

When the operation is complete, disconnect the IEEE1394 
cable if necessary.

To remove an XDCAM drive
Click the eject button to the right of the XDCAM drive 
icon in the Finder, or drag the disc icon to the trash icon.

When the operation is complete, disconnect the USB cable 
if necessary.

Handling SxS memory card files

You can access SxS memory cards inserted in devices 
connected as follows from a computer on which the SxS 
Device Driver or the SxS UDF Driver (when using UDF 
format) is installed.

• Connected via the ExpressCard slot on the computer
• Card readers/writers connected to the computer via USB
• XDCAM EX/XDCAM devices connected to the 

computer via USB

Information recorded for materials stored on an SxS 
memory card may span multiple files and folders. 
XDCAM Browser allows you to handle this information 
and file directories easily, without worrying about 
structure. However, if you use the Finder to perform 
operations such as copying clips from the SxS memory 
card, the information stored with the clip may not be 
retained. To prevent such occurrences, we recommend 
performing file operations using supported applications.

For details on switching operation modes or information 
on device limitations, refer to the operating instructions for 
each device.

Limitations and restrictions
• Do not perform the following operations while the 

computer is accessing the SxS memory card.
- Turn ON/OFF the XDCAM EX/XDCAM device or 

memory card reader/writer
- Remove or insert SxS memory cards
- Disconnect or connect USB cables
- Change the setting of the write protect switch on an 

SxS memory card

• If the SxS memory card icon is displayed in the menu 
bar, do not right click the icon and select the power off 
option.

Ending SxS memory card operations

When using a card inserted in an ExpressCard 
slot
When you are finished with operations, perform the 
procedure for safely removing devices from your 
computer before removing the device. Do not disconnect 
the device until the removal process is complete.

1 Drag the SxS memory card icon from the desktop to 
the trash (eject) icon, or click the eject button to the 
right of the SxS memory card icon in the Finder.

2 Confirm that the SxS memory card icon has 
disappeared, and remove the card.

Do not select the power off option from the SxS memory 
card icon displayed in the menu bar.

When using an XDCAM device or memory card 
reader/writer connected by USB

1 Either drag the SxS memory card icon on the desktop 
to the trash icon, or click the eject button to the right of 
the SxS memory card icon in Finder.

2 Confirm that the SxS memory card icon has 
disappeared and that the access lamp on the SxS 
memory card is out, and then remove the card or 
unplug the USB cable.

Note
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Introduction

This section describes the Sony retail option functions 
included with XDCAM Browser.

For details about the required MainConcept Conversion 
Pack for format conversion when copying or exporting 
clips, see “If the MainConcept plug-in software is 
installed” (page 7 or page 13). 

Overview

This application provides the following functions as Sony 
retail options. 
• Writing to BD/DVD (writing to DVD is only available 

on the Windows version)*
• Creating and editing planning metadata*
• Live logging function*
• Exporting list information about clips/clip lists*
• Configuring essence marks using essence mark lists*
• Displaying acquisition metadata
• Creating AAF files from clip lists (Windows version 

only)
• Using clip lists to compile proxy AV data and create 

WMV files (Windows version only)
• Displaying audio level meters
• Adding subclips using essence marks

“[Trial]” is displayed after the item name for each of the 
retail option function menu items. 
Although the retail option functions marked with asterisks 
(*) above can be used on a trial basis for 30 days after the 
initial installation, they will be disabled after the trial 
period expires unless you purchase and register a serial 
number for either the XDBZ-AD1 Professional 
Application Software (advanced pack for XDCAM 
Browser) or the retail options. However, data created 
during the trial period can be used without change after the 
trial period expires. 

• In order to use the retail option functions after the trial 
period, it is necessary to register a serial number using an 
Internet connection. Even if the target computer for the 
serial number cannot connect to the Internet, you can 
still register by obtaining an authentication code using 
another computer that can connect to the Internet. 

• A serial number and an authentication code are both 
required for each computer running this application. 

Retail Option 
Functions

Notes
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During the trial period, the following dialog appears each 
time you use a retail option function notifying you when 
the trial period will expire. 

To continue using the retail option functions after the trial 
period has expired, it is necessary to purchase and register 
a serial number. After registering a serial number, “[Trial]” 
is no longer displayed after the retail option function menu 
items. 

You can check the status of whether the retail option 
functions can be used or not in the version information 
dialog for this application. Select [About XDCAM 
Browser…] from the [Help] menu on Windows, or [About 
XDCAM Browser] from the [XDCAM Browser] menu on 
Mac OS to display the following dialog. (The following 
dialog is for Mac OS X. The same information is also 
displayed for Windows.) 

Purchasing a Serial 
Number

A purchased serial number is required in order to activate 
the retail option functions.
Please store in a safe location.

If XDCAM Browser was supplied on 
CD-ROM with an XDCAM Device or 
downloaded from the website

Purchase a serial number from the Sony Creative Software 
Inc. web site below. 
http://www.sonycreativesoftware.com/

An Internet connection is required to access the Sony 
Creative Software Inc. website to purchase a serial 
number. 

If XDBZ-AD1 (advanced pack for 
XDCAM Browser) was purchased

The serial number is provided on an accompanying sheet 
of paper.

The dialog displays the number of days left during the trial 
period, and displays “Trial expired.” after the trial period has 
expired. 
The dialog displays the registered serial number after a serial 
number has been registered. 

Note

Note
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Registering a Serial 
Number

You register the obtained serial number on the computer 
that will use the retail option functions. 

• An Internet connection is required to access the Sony 
Creative Software Inc. website to register a serial 
number. If the computer that will use the retail option 
functions cannot connect to the Internet, you will need 
another computer that can access the website. 

• This operation requires administrator execute privileges. 
• The following dialogs are for Mac OS X. The same 

information is also displayed for Windows. 

1 Launch XDCAM Browser (this application) on the 
computer that will use the retail option functions. 

For details, see “Launching the application” (page 8) 
for Windows or “Launching the application” (page 
15) for Mac OS. 

2 Select [Register Serial Number] from the [Help] menu 
on Windows or the [XDCAM Browser] menu on Mac 
OS. 

The [Register Serial Number] dialog appears.

3 Click [Execute].

The following screen appears.

On Windows XP, an error message will appear if you 
execute without administrator privileges. Re-execute 
with administrator privileges.
On Windows Vista, Windows 7, or Mac OS, a dialog 
appears asking whether you want to execute with 
administrator privileges, then the operation continues.

4 Enter the serial number obtained in “Purchasing a 
Serial Number” (page 18) in the empty field, then 
click [Next].

Enter the number as is, including hyphens. 

The following screen appears. 

The procedure divides into two from this point.
If you can access the Sony Creative Software Inc. 

website from the target computer: 
Continue the procedure from the next step. 

If you cannot access the Sony Creative Software 
Inc. website from the target computer: 
Follow the procedure described in “If you cannot 
access the Sony Creative Software Inc. website from 
the target computer:” (page 20). 

Notes

Note
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5 Select the [Register online] option, then click [Next].

A message indicating that the serial number is being 
registered appears, and registration begins. 
If the number is registered successfully, the following 
screen appears. 

6 Click [Finish]. 

The serial number registration finishes. 

7 Exit XDCAM Browser, then relaunch the application. 

After relaunching the application, you will be able to 
use the application without “[Trial]” displayed after 
the retail option function menu items. 

If you cannot access the Sony Creative 
Software Inc. website from the target 
computer: 
It will be necessary to obtain an authentication code apart 
from the serial number using a computer that can access 
the Sony Creative Software Inc. website. Then you enter 
the authentication code into the computer that will use the 
retail option functions in order to activate them. 

The process flow is as follows. 
(1) On the computer that will use the retail option 

functions, create a file for authentication that contains 
information about the computer. 

(2) Access the Sony Creative Software Inc. website from 
another computer, and obtain an authentication code 
using the file created in step (1).

(3) Enter the authentication code into the computer that 
will use the retail option functions. 

1 Execute steps 1 to 4 in “Registering a Serial Number” 
(page 19) to display the following screen. 

2 Select the [Register from another computer] option, 
then click [Next].

The following screen appears. 

3 Insert USB memory or other removable media, then 
click [Next].

A dialog for saving the file appears. 

4 Click [Save]. 

An htm file for authentication is created and saved, 
then the following screen appears. 
Registering a Serial Number
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5 Copy the htm file for authentication to the removable 
media and transfer it to a computer that can access the 
Sony Creative Software Inc. website. 

You can click [Cancel] to close the [Register Serial 
Number] dialog once this point is reached if the 
following process will take time or for other reason. 

6 On the computer that can access the Sony Creative 
Software Inc. website, double-click the htm file for 
authentication. 

The computer automatically accesses the Sony 
Creative Software Inc. website and displays the 
authentication webpage. 

7 Enter the required information on the authentication 
webpage, then click [Submit]. 

The authentication process runs on the Sony Creative 
Software Inc. website and then displays the 
authentication code on the screen. 
The same code is also sent to the entered email 
address. 

8 Make a note of the authentication code or save it to 
removable media as a text file and transfer it to the 
computer that will use the retail option functions. 

9 On the computer that will use the retail option 
functions, click [Next] in the [Register Serial Number] 
dialog. 

If you closed the [Register Serial Number] dialog in 
step 5, reopen the dialog, select the [Register from 
another computer] option, and place a check mark in 
the [I already have an Authentication Code] check 
box, then click [Next].

The following screen appears. 

10Enter the obtained authentication code in the empty 
field or copy and paste it from a text file, then click 
[Finish]. 

Enter the number as is, including hyphens. 

The serial number registration finishes. 

11Exit XDCAM Browser, then relaunch the application. 

After relaunching the application, you will be able to 
use the application without “[Trial]” displayed after 
the retail option function menu items. 
21Registering a Serial Number
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